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1 Introduction

Welcome to MeetingPlace—the e-conferencing system for your 
enterprise. MeetingPlace allows users in different locations to 

collaborate in real time through live voice communication and by 

sharing applications on their PCs. 

Because MeetingPlace integrates with common interfaces, such 

as standard PSTN and Cisco IP telephones, groupware clients, 
Web browsers, and wireless handheld devices, users can quickly 

schedule and attend e-conferences through their preferred 

interface from any location.

Who Should Use This Guide
This guide is designed for the MeetingPlace Directory Services 

System Manager. It provides useful guidelines for managing and 

maintaining the MeetingPlace system, and offers 

recommendations to aid you in making the right decisions for 
your organization.

This guide assumes that you are familiar with networking and 

directory services concepts, as well as have an understanding of 
how MeetingPlace operates on your network.

MeetingPlace Directory Services System Manager 
Functions 

As the MeetingPlace Directory Services System Manager, you 

will be responsible for the following functions:

• Installing and configuring MeetingPlace Directory Services

• Maintaining communication with your organization’s 

corporate directory system manager

• Performing maintenance and troubleshooting on an ongoing 

basis
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Other Documents Available
For additional copies of this document or for additional 
documentation offered by Latitude Communications, contact 
your MeetingPlace Support or Sales Representative.

For System Managers

• MeetingPlace Installation Planning Guide. Instructions 

and worksheets that prepare you for installing MeetingPlace 

and the various system options.

• MeetingPlace System Manager’s Guide. Describes how to 

configure and maintain MeetingPlace after the system has 

been installed.

• MeetingPlace Data Conferencing System Manager’s 

Guide. Instructions for installing the MeetingPlace Data 

Conference server and using the various data conferencing 

applications.

• MeetingPlace Rollout Planning Guide. Tools for training 

others and promoting the use of MeetingPlace in your 
organization. These tools include internal company 

announcements, training materials, and user tips.

For MeetingPlace Users

• MeetingPlace Quick Reference Card. A “map” to all 
MeetingPlace functions that are available over the telephone, 
plus quick tips for setting up better meetings.

• MeetingPlace Wallet Card. A plastic wallet-sized card that 
shows the basic telephone commands for scheduling and 

attending meetings.

• Voice Quick Tour. An overview of the voice user interface 

features for first-time users.
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Online Documentation

• Online Help. Detailed instructions for using MeetingTime 

and MeetingPlace.

• MeetingPlace Virtual Help Desk. A browser-based tool that 
assists help desk staff in supporting MeetingPlace features 

and troubleshooting end user problems. Built-in search 

capabilities enable quick access to relevant information. This 

tool is accessible from the Help menu in MeetingTime.

• MeetingPlace InfoCenter. A self-service Web site designed 

to educate end users about MeetingPlace. This customizable 

rollout tool is automatically installed with MeetingPlace 

Web. 

Getting Technical Assistance
Should you have questions about MeetingPlace Directory 

Services, Latitude Communications and its authorized 

distributors are available to help you within the guidelines of your 
support program.

When you call, be ready to provide the following information:

• The version of MeetingPlace Directory Services (from the 

directory you installed MeetingPlace Directory Services, 
right-click MPML.dll and select Properties). ____________

• The version of your MeetingPlace system software (after 
logging into MeetingTime, go to Help, and select About 
MeetingTime).  ____________________________________

• The exact wording of any messages or alarm codes reported.
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2 Getting Started—A 
MeetingPlace 
Overview

This chapter provides you with an overview of how MeetingPlace 

works and integrates with your organization’s network. This 

chapter also provides information about MeetingTime, 
MeetingPlace Data Conferencing, and the MeetingPlace gateway 

options.

MeetingPlace Concepts
MeetingPlace uses your organization’s existing IP-based         

and/or telephony infrastructure to provide voice and data 

conferencing using Cisco IP and standard PSTN phones.

MeetingPlace can also integrate with your organization’s 

standard e-business applications, such as e-mail, fax, and wireless 

hand-held devices. To facilitate integration with these resources, 
system options are installed on a Windows-based server that 
communicates with MeetingPlace over your network.

Figure 2-1 displays how the entire MeetingPlace family 

integrates with your organization’s network.
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Figure 2-1  How MeetingPlace Integrates with your 

Organization’s Network 

MeetingPlace manages the entire meeting process by performing 

key functions before, during, and after a meeting. These functions 

include scheduling a meeting, notifying and assembling 

participants, distributing meeting materials, and allowing users to 

take advantage of in-meeting features like roll call, record and 

lock meeting.

MeetingPlace Networked Systems

To expand system capacity to meet increasing conferencing 

needs, up to eight MeetingPlace conference servers can be 

networked together. When MeetingPlace conference servers are 

networked together, a MeetingPlace network server is needed to 

facilitate communication between the conference servers and to 
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store key information within its database. Figure 2-2 displays the 

setup of a networked MeetingPlace system. 

The MeetingPlace network server provides a single point for 
scheduling and managing the other conference servers. This 

includes database configuration, reporting, backup, and 

management of all user profiles. The MeetingPlace network 

server also provides the MeetingPlace gateways with a single 

point of communication. 

 

Figure 2-2  How a MeetingPlace Networked System Integrates 

with your Organization’s Network
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MeetingTime

MeetingTime is a client software application that runs on 

Windows desktop computers. 

System managers use MeetingTime to run reports, configure the 

system, manage capacity, and perform routine system 

management functions. MeetingTime can also be used by your 
organization’s help desk department to handle end user problems 

and issues.

MeetingTime communicates with a MeetingPlace server over the 

local or wide area network using TCP/IP, the industry-standard 

networking protocol.

Figure 2-3 shows the MeetingTime Register Book, which 

provides access to advanced MeetingPlace functions that are not 
available over the phone or with MeetingPlace Web.

Figure 2-3  MeetingTime Register Book
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Data Conferencing

Data conferencing allows multiple individuals to share and 

collaborate on the same document in real time using their desktop 

or laptop computer. 

The MeetingPlace Data Conferencing server communicates 

directly with MeetingPlace and is installed on the same Windows 

server as MeetingPlace Web. This direct communication with 

MeetingPlace enables users to schedule a single conference 

instead of individual data and voice meetings.

Data conferencing is ideal for:

• Slide show presentations

• Document reviews

• Sharing applications

• Distance learning sessions

MeetingPlace Gateway Options
MeetingPlace gateway options are designed to integrate 

MeetingPlace with an organization’s existing communication 

tools, such as:

• Web servers

• E-mail and fax servers

• Groupware products like Microsoft Outlook and Lotus Notes

The following sections describe each of the MeetingPlace 

gateway options.

MeetingPlace Web

MeetingPlace Web is a Windows-based software product that 
integrates MeetingPlace with your organization’s Web server. 
The software enables users to schedule and attend meetings and 
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access meeting recordings from common Web browsers such as 

Netscape Navigator and Microsoft Internet Explorer.

Because most individuals within an organization are accustomed 

to using their Web browsers to connect to the Internet or their 
organization’s intranet, MeetingPlace Web provides a user-
friendly interface for scheduling and attending meetings. Figure 

2-4 displays the MeetingPlace Web interface.

Figure 2-4  MeetingPlace Web Scheduling Interface

For more information about MeetingPlace Web, refer to the 

MeetingPlace Web System Manager’s Guide.

MeetingPlace E-mail and Fax Gateways

The MeetingPlace E-mail Gateway and MeetingPlace Fax 

Gateway enable a MeetingPlace system to communicate with an 

organization’s existing e-mail and fax servers. This 

communication allows MeetingPlace to notify participants and 

distribute meeting materials via e-mail and fax.
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These gateways can either reside on the same system as your 
e-mail or fax server or on a separate Windows server. 

For more information, refer to the MeetingPlace E-mail Gateway 

System Manager’s Guide and the MeetingPlace Fax Gateway 

System Manager’s Guide.

MeetingPlace for Microsoft Outlook and Lotus Notes

To allow users to schedule and attend meetings through their 
groupware client, MeetingPlace can integrate with Microsoft 
Outlook and Lotus Notes.

Once a meeting is scheduled, MeetingPlace is able to use an 

organization’s existing Exchange or Domino server to deliver 
meeting notifications to the invited users. If a user chooses to 

accept a notification, the meeting automatically appears in their 
Outlook or Notes calendar.

For more information, refer to the MeetingPlace for Outlook 

System Manager’s Guide or the MeetingPlace for Notes System 

Manager’s Guide.
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3 MeetingPlace 
Directory Services 
Concepts

This chapter provides you with an overview of MeetingPlace 

Directory Services concepts. Understanding these concepts is 

helpful with installing and maintaining MeetingPlace Directory 

Services. The topics covered in this chapter include:

• Directory Servers

• Lightweight Data Access Protocol (LDAP)

• MeetingPlace Directory Services Architecture

• MetaDirectory and the MetaLink Agreement

Directory Servers
A directory server is used to logically store directory information. 
It helps to centralize users, groups, and access, which in turn, 
helps to simplify maintenance of your organization’s directory 

information. You can then use MeetingPlace Directory Services 

to synchronize this information with your MeetingPlace profiles.
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Currently, MeetingPlace Directory Services interacts with the 

following directory servers:

• Microsoft Active Directory – allows you to store, access 

and manipulate organizational information about users and 

resources. It is a vital component of Windows 2000 and 

enables you to manage all elements of a networked 

environment (computers, groups, users, policies and other 
user-defined objects). 

• Netscape LDAP Directory Server – unlike an application 

directory such as Microsoft Exchange, Netscape is a general 
purpose LDAP directory that stores, publishes and centrally 

manages users and network resources.

 Lightweight Data Access Protocol
Lightweight Data Access Protocol (LDAP), is a directory 

services protocol that runs atop TCP/IP. It is an easily deployed, 
efficient, and highly functional protocol that allows you to search 

dynamically throughout a system to retrieve data. Typically, it is 

used among organizations to structure disparate e-mail, network, 
and human resource databases so that directory information such 

as an address, resource or department number can be obtained.

The LDAP directory is designed as a simple “tree” hierarchy 

known as a Directory Information Tree (DIT). This hierarchy 

provides a method for logically grouping and subgrouping similar 
information together. 
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A DIT is based on a root directory that can include several 
subtrees. As displayed in Figure 3-1, a typical DIT consists of the 

following subtrees:
• country, c, which branches out to

• organization, o, which branches out to

•  organizational unit, ou, which branches out to

•  common name, cn.

Figure 3-1  LDAP Directory Information Tree

MeetingPlace Directory Services Architecture
MeetingPlace Directory Services easily integrates with your 
existing network to provide you with the profile maintenance 

tools used to add, update and delete MeetingPlace profiles. This 

allows you to keep all the elements of the MeetingPlace profiles 

in sync with the information stored on your corporate directory 

server. Figure 3-2 displays how MeetingPlace Directory Services 

integrates with your network.



16 Chapter 3  MeetingPlace Directory Services Concepts 

MeetingPlace Directory Services System Manager’s Guide Latitude Communications

Figure 3-2  MeetingPlace Directory Services Architecture

The MeetingPlace Directory Services software, installed on a 

Windows server, facilitates communication between your 
corporate directory server and the MeetingPlace server. It is 

responsible for updating MeetingPlace users’ profiles with 

organizational information located on your corporate directory 

server. 

Figure 3-3 displays how MeetingPlace Directory Services 

interacts between your corporate directory server and the 

MeetingPlace server.
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Figure 3-3  MeetingPlace Directory Services Overview

MetaDirectory and the MetaLink Agreement
What is a MetaDirectory? A MetaDirectory is a unified, 
commonly accessible infrastructure that converges an 

organization’s dispersed directories. Creating a single directory 

allows you to simplify management and administrative tasks. 
MetaDirectory functionality is provided by a MetaLink 

agreement.

A MetaLink agreement creates, updates, and deletes 

MeetingPlace user profiles based on information stored on your 
corporate directory server. The MeetingPlace Directory Services 

server acts as the gateway for each MetaLink agreement between 

the two servers. To utilize MeetingPlace Directory Services, a 

MetaLink agreement must exist between the:

• MeetingPlace server and the MeetingPlace Directory 

Services server 

• MeetingPlace Directory Services server and your corporate 

directory server
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Standard Synchronization and Correlation

A MetaLink agreement is powered by the synchronization 

process. The synchronization process is responsible for 
exchanging data between MeetingPlace and your corporate 

directory system. 

It is comprised of standard synchronization and correlation, 
which use standard attribute mapping and BootStrap attribute 

mapping to offer seamless integration of your directory 

information. Once information changes on your corporate 

directory server, updates propagate to MeetingPlace Directory 

Services via the MetaLink agreement. 

Initially, you can expect the entries to propagate the 

MeetingPlace Directory Services server at a rate of about one 

profile per second. 

Each time the MeetingPlace Directory Services server imports 

data, it goes through a process to determine whether the entry has 

been imported before. 

If this is the first time an entry is being imported into 

MeetingPlace from your corporate directory server, it uses 

correlation to either create, update or delete a MeetingPlace 

profile. If the entry has been imported into MeetingPlace before, 
it uses standard synchronization to update or delete the 

MeetingPlace profile.

Both correlation and standard synchronization are performed by 

matching the value of one or more attributes on one server with a 

corresponding attribute on another server. This attribute mapping 

is an essential component of correlation and standard 

synchronization.
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Standard and BootStrap Attribute Mapping

Attribute mapping is a flexible and powerful tool that allows you 

to map attribute values between entries in MeetingPlace and your 
corporate directory system. You create, update, and delete 

MeetingPlace profiles based on the information obtained from 

similar attributes in your corporate directory system. 

For example, you could obtain a first name, last name, e-mail 
address, and phone number for each employee from your 
corporate directory server. Through attribute mapping, you can 

then update MeetingPlace profiles with that information.

Attribute mapping rules allow you to use more than a simple one-
to-one mapping between attributes including:

• Concatenating the values of different attributes with other 
attributes or constant strings

• Selecting the first attribute that has a value from a list

• Applying custom mappings and conversions to the attribute 

values

Attribute mapping only occurs when standard synchronization is 

used in a MetaLink agreement. So, if a user profile has been 

imported into MeetingPlace before, you can use attribute 

mapping to update or delete the profile.

Much like attribute mapping, BootStrap attribute mapping allows 

you to map attribute values between entries in MeetingPlace and 

your corporate directory server. However, BootStrap attribute 

mapping only occurs when an entry is first imported into 

MeetingPlace. It is used during correlation to ensure that no two 

entries are created for the same user. Since it only occurs during 

correlation, BootStrap attribute mapping will not affect the 

standard synchronization process. 

Both standard and BootStrap attribute mappings can utilize plug-
in functions to manipulate an attribute’s value when it is imported 

3

3
3

33
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into MeetingPlace. Plug-in functions are discussed in detail in 

Chapter 5, and a list of available plug-in functions is available in 

Appendix B.

For additional information on attribute mapping, see Chapter 5.

Configuration Files

A configuration file stores the parameters used for a MetaLink 

agreement. It defines which two systems are involved in the 

agreement, what type of attribute mapping will be used and 

which attributes will be correlated and/or synchronized. Each 

configuration file is unique and distinguished by these 

parameters. 

MeetingPlace Directory Services provides default configuration 

files for each type of directory server supported. These default 
configuration files provide some sample parameters to create the 

initial agreement between the two servers. 

Once you have created the initial MetaLink agreement and you 

have a configuration file, you can modify that file to create a new 

MetaLink agreement.

Suspense Files

A suspense file is a text file that is generated to record any errors 

that occur when a MetaLink agreement is run. 

Some common failures include:

• Directory overload – occurs when the server is too busy to 

perform the import or export of data.

• Duplicate entry – occurs when MeetingPlace Directory 

Services recognizes an entry has already been imported (e.g. 
case-sensitive, DSmith and dSmith).

• Attribute mappings – occurs when a value could not be 

obtained for an attribute mapping (e.g. when used with the 

5
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mandatory plug-in function, %deptno, where some entries 

do not have a department number assigned to them).

Now that you have a basic understanding of MeetingPlace 

Directory Services concepts, you should install the software. 
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4 Installing MeetingPlace 
Directory Services 

This chapter describes the MeetingPlace Directory Services 

system requirements and installation process. The following 

information is included:

• Preparing for the MeetingPlace Directory Services 

Installation

• MeetingPlace Directory Services System Requirements

• Installing MeetingPlace Directory Services

• Testing the MeetingPlace Directory Services Installation

Preparing for Installation
Preparing for the installation process may prevent issues from 

arising while configuring MeetingPlace Directory Services for 
your network. Table 4-1 provides information that you should 

have available prior to the installation process. 

Description Value

1. The MeetingPlace server hostname or 
IP address.

hostname ________________________

IP address________________________

2. Is the MeetingPlace server a network 

server?
Yes_____     No_____

3. The MeetingPlace server version 

number.
version number ____________________
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4. The number of profiles in 

MeetingPlace.

• Refer to the MeetingPlace System 

Manager’s Guide for instructions on 

how to retrieve this number.

number of profiles__________________

5. The MeetingPlace user name and 

password.

• This account must have system 

manager rights.

user name_________________________

password__________________________

6. The MeetingPlace Directory Services 

server hostname or IP address.
hostname  _________________________

IP address________________________

7. The MeetingPlace Directory Services 

server user name and password.

• This account must have local 
administrative rights.

user name________________________

password  _________________________  

8. The MeetingPlace Directory Services 

Administration Tool user DN and 

password.

• This account will be created during 

MeetingPlace Directory Services 

installation.

user DN __________________________

password__________________________

9. The MeetingPlace Directory Services 

suspense file directory.
directory _________________________

10.The corporate directory server      
hostname or IP address. 

hostname _________________________

IP address ________________________

11.The corporate directory server admin 

node and subtree (LDAP only).
admin node _______________________

subtree ___________________________

Description Value
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Table 4-1  What You Need to Know to Install MeetingPlace 

Directory Services

For Netscape LDAP Directory Services System Managers 

If your corporate directory server is Netscape LDAP, the first 
thing you should do prior to installing MeetingPlace Directory 

Services is determine who will be responsible for resetting the 

LDAP ChangeLog. 

The ChangeLog keeps track of all changes made to your 
corporate directory server. Once a change is made, it is recorded 

in a file, in a chronological index, with a number representing its 

order of creation. 

MeetingPlace Directory Services keeps track of this index 

number to determine the state of your corporate directory server 
each time a MetaLink agreement is run. This ensures that the 

latest version of your corporate directory is synchronized with 

your MeetingPlace profiles as defined by the MetaLink 

agreements.

If the ChangeLog is reset, you will have to take appropriate steps 

to compensate for the change. These steps are provided on 

page 103.

12.The number of profiles in the 

corporate directory server.

• Contact your corporate directory 

server system manager.

number of profiles__________________

13.The corporate directory server port 
number.

• Contact your corporate directory 

server system manager.

port number_______________________

Description Value
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MeetingPlace Directory Services System 
Requirements

The following section provides the MeetingPlace Directory 

Services system requirements. You should make sure all 
requirements are met before installing MeetingPlace Directory 

Services.

System Requirements

1. MeetingPlace 

Directory 

Services 

Server

• Windows 2000 or Windows NT 4.0 (requires 

service pack 5.0 or later) 

• 500 MHz Pentium II/III processor

• 512 MB RAM

• 4GB hard drive (for installation and suspense 

files)

• NTFS partition

• Network Interface Card (100 Mbps)

• CD-ROM drive for software installation

• Microsoft Windows Networking Support

• Microsoft Internet Explorer (version 5.0 or later 
for recommended backup process)

• VGA (1028 x 768) display (SVGA recommended)

Note:  The account used to access this server must 
have local administrative rights with the ability to 

start and stop services.

�

2. MeetingPlace 

Server 
• MeetingPlace 2000.2 (version 4.1.3h or later)

• MeetingPlace Directory Services license key

�
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Table 4-2  MeetingPlace Directory Services System 

Requirements

3. Network • TCP/IP protocol

• Connectivity between the MeetingPlace Directory 

Services server and the MeetingPlace server must 
be high quality and not subject to interruptions due 

to traffic congestion. Any time the round trip 

latency exceeds 100ms or there is more than 1% 

packet loss, a noticeable reduction in service 

quality should be expected.

�

4. End User One of the following directory servers: 

• Netscape LDAP Directory version 4

Note:  You must have read and search rights on 

the Changelog property and the subtree(s) you 

will extract data from.

 You must also have access privileges to read  

the entire subtree at once.

• Microsoft Active Directory version 5.5

Note:  You must have replication directory 

changes, replication synchronization, and read 

rights on this domain.        

�
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Installing MeetingPlace Directory Services

Table 4-3  

If you are running other MeetingPlace gateways that utilize the 

MeetingPlace Agent Service, you should stop the service prior to 

installing MeetingPlace Directory Services. This will enable the 

setup program to run more efficiently by releasing system 

resources.

To stop the MeetingPlace Agent Service, go to Start | Settings | 
Control Panel | Services. From the list of services, select the 

MeetingPlace Agent Service and click Stop.

To install MeetingPlace Directory Services:

1.  Insert the MeetingPlace Directory Services CD into the 

Windows server CD-ROM drive. Click Next.

If the installation wizard fails to start (e.g. autorun is 

disabled), go to Start | Run and enter X:\SETUP, where X: 
refers to the CD-ROM drive. Click OK.
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2.  From the MeetingPlace Directory Services screen, click Next 
to accept the default directory or click Browse to specify a 

directory (4GB disk space required). 

3.  From the MeetingPlace Gateway SIM screen, click Next to 

accept the default directory or click Browse to specify a 

directory.

4.  If the Confirm New Folder screen appears, click Yes to create 

the MeetingPlace Gateway SIM directory.
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5.  If the Remote Management Entry screen appears, click Yes to 

accept remote management commands for MeetingPlace.

Should a problem occur, an experienced MeetingPlace 

support technician can remotely access your system and 

troubleshoot MeetingPlace for you.

6.  From the MeetingPlace Directory Gateway Log Directory 

Entry screen, click Next to accept the default directory or 
click Browse to specify a directory.
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7.  From the MeetingPlace Server Entry screen, enter the 

hostname or IP address of the MeetingPlace server and click 

Next.

8.  From the Select Program Folder screen, click Next to select 
the default program folder or enter a new program folder 
name in the space provided. 
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9.  Wait for setup to copy files to the specified directory.

10. From the Admin Node screen, enter the admin node that will 
be managed by MeetingPlace Directory Services and click 

Next. 
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11.  From the NT Password screen, enter the password that allows 

you to log on and access the MeetingPlace Directory Services 

server. This account must have administrative rights.

12. From the MeetingPlace Suspense File Location screen, click 

Next to accept the default directory or click Browse to 

specify a directory.

13. If you do not have Java Run-Time Environment version 1.2 

or later, it should now be installed by the installation wizard. 
If it is already installed, skip to Step 17.
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14. From the Software License Agreement screen, click Yes to 

accept the terms of the agreement.

15. From the Java Run-Time Environment Install screen, click 

Next to accept the default directory or click Browse to 

specify a directory. 

16. Setup will finish installing the files.

17. To complete the MeetingPlace Directory Services 

installation, you will have to restart your computer. Click 

Finish. 

18. Once the system reboots, enter the user name for the 

MeetingPlace Directory Services Admin Tool. Click Next. 
The account used to access the admin tool will now be 

created.

19. From the MeetingPlace Directory Services Password screen, 
enter the password for the MeetingPlace Directory Services 

Admin Tool. Click Next. The password for the above account 
will now be created.
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Testing the MeetingPlace Directory Services  
Software Installation

Perform the following steps to verify the MeetingPlace Directory 

Services software was installed properly:

1.  From Start | Settings | Control Panel | Services, verify the 

following services are running:

• MeetingPlace Gateway SIM

• MeetingPlace Directory Server

2.  From Start | Programs | MeetingPlace Applications | 
MeetingPlace Gateway Configuration, verify the status is 

connected. 

3.  From Start | Programs | DC Directory Administrator, perform 

the following steps:

• From the Log on to DC Directory Admin – Step 1 of 2 

screen, click Next.

• From the Log on to DC Directory Admin – Step 2 of 2 

screen, enter the user name and password, and click 

Finish.

• From the DC Directory Admin screen, right-click the 

admin node from the left panel and select New. 

• Verify that MeetingPlace User is available.
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4.  At this time, you may also want to make sure the directory to 

store the suspense files exist. This is the directory you 

specified in Installing MeetingPlace Directory Services, Step 

12.

Now that you have installed MeetingPlace Directory 

Services, you must configure the MetaLink agreements to 

begin the synchronization process.
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5 Managing 
MeetingPlace Directory 
Services 

This chapter provides you with information about using 

MeetingPlace Directory Services. The topics covered in this 

chapter include:

• Managing a MetaLink Agreement

• Viewing a Suspense File

• Backing up Your Work

Managing a MetaLink Agreement
The MetaLink agreement is the driving force behind 

MeetingPlace Directory Services. A MetaLink agreement is made 

up of several parameters. It is important to understand how to 

utilize these parameters before creating the agreement. The topics 

covered in this section include:

• MeetingPlace Profiles

• Mapping an Attribute

• Using a Correlation Rule

• Using a Plug-in Function

• Using a Configuration File

• MetaLink Management Utility Script



38 Chapter 5  Managing MeetingPlace Directory Services 

MeetingPlace Directory Services System Manager’s Guide Latitude Communications

MeetingPlace Profiles

A MeetingPlace profile, which uniquely identifies each 

MeetingPlace user, can be made up of several attributes. 
Minimally, a MeetingPlace profile consists of a case-sensitive 

user name and profile number.

Once you run the initial MetaLink agreement between the 

MeetingPlace Directory Services server and the MeetingPlace 

server, any changes made to directory information that involve 

the mapped attributes should be made on your corporate directory 

server only. If you make a change to a profile in MeetingPlace, 
and then run a MetaLink agreement, the change will be 

overwritten by the information on your corporate directory 

server.

Mapping an Attribute 

In a MetaLink agreement, entries can be synchronized using 

either BootStrap or standard attribute mapping. The type of 
attribute mapping, as well as which attributes to map, is 

determined by you when you create the MetaLink agreement. 
Provided there are no errors, the attributes are mapped once the 

MetaLink agreement is run. If an error does occur, it will be 

written to the suspense file.
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Once a MetaLink agreement is run, correlation is used to 

determine if the entry, or profile, already exists in MeetingPlace. 
If the profile does exist, standard synchronization uses standard 

attribute mapping to update the profile with the information from 

your corporate directory server. 

If the profile does not exist, correlation uses BootStrap attribute 

mapping to create a new profile. BootStrap attribute mapping is 

an effective way to perform certain mappings when an entry is 

first imported into MeetingPlace. 

For example, in BootStrap attribute mapping you can map the 

password attribute to a generic value of 1234. When a 

MeetingPlace profile is created initially, it will be assigned a 

password value of 1234. When a user logs into MeetingPlace for 
the first time, he can access his profile using this generic 

password. Once the user accesses his profile, he can change the 

password to a more secure password. Since BootStrap attribute 

mapping only occurs when a profile is first created, it will not 
perform updates to profiles that already exist in MeetingPlace. 

When you create attribute mappings, you can specify that an 

attribute must have a value before it gets propagated to 

MeetingPlace. The % sign preceding an attribute ensures that the 

attribute value is mandatary. 

For example, you can map %LastName=sn so that last name 

attribute on the source server is mapped to the sn attribute on the 

destination server. The % sign guarantees that the last name 

attribute must have a value to be propagated to MeetingPlace. If 
the attribute does not have a value, an error will be written to the 

suspense file, and the gateway will proceed to the next entry in 

the directory.



40 Chapter 5  Managing MeetingPlace Directory Services 

MeetingPlace Directory Services System Manager’s Guide Latitude Communications

Using a Correlation Rule

In a MetaLink agreement, correlation rules are used to link 

entries in two directory servers. It is an important part of the 

synchronization process, because it determines which entry in the 

destination server corresponds to which entry in the source 

server. 

Only one correlation rule needs to give a match for a destination 

entry to correlate with a source entry. Each rule consists of at 
least one attribute mapping, where each source and destination 

attribute needs to be the same value in order for the rule to 

correlate.

You can consider a correlation rule to be part of a logical OR 

statement, and the attribute mappings within the correlation rule 

part of a logical AND statement.

A correlation rule accomodates both simple and complex 

correlations. The directory server may have a natural correlator 
(e.g. unique employee number) or a combination of correlators 

(e.g. first name, last name, and department number) that establish 

a correlation rule. 

You can combine a number of correlation rules to create complex 

rules which include logical AND operators, string constants and 

equality tests.

It is important to consider which attributes to use when creating a 

correlation rule. The value, or combination of values, must be 

unique in both MeetingPlace and your corporate directory server. 
If the value of these attributes is not unique, multiple entries 

could correlate into a single entry. Also, the attributes used in the 

correlation rule must exist in all entries in both MeetingPlace and 

your corporate directory server. 

Additionally, it is important to remember that if correlation can’t 
be made between entries in MeetingPlace and your corporate 

directory server, then a new entry will be created using BootStrap 

attribute mapping. Therefore, a correlation rule must be defined 
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properly to ensure this doesn’t happen if there are corresponding 

entries (e.g. not correlating when there is a match). You should 

also consider which key values (e.g. fullDistName) will be 

unique when BootStrap attribute mapping occurs.

The following section details how to add and delete a correlation 

rule while creating a MetaLink agreement using the 

MeetingPlace Directory Services Admin Tool. These instructions 

assume you are starting from the Correlation Rules screen of the 

MetaLink agreement, as detailed on page 78 and page 90, and are 

for either type of corporate directory currently supported by 

MeetingPlace Directory Services. You should use this method if 
your corporate directory server has less than 50,000 entries to 

export to MeetingPlace Directory Services.

If your corporate directory server has more than 50,000 entries, 
you should modify the configuration file to create the MetaLink 

agreement. Details on how to add and edit a correlation rule by 

modifying the configuration file are provided on page 93.
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    To add a correlation rule:

1.  From the Correlation Rules screen, click New.

2.  Enter the name of the correlation rule. Click OK.

To add an attribute to a correlation rule:

1.  From the Correlation Rules screen, select the correlation rule 

that you want to modify from the Correlation Rules drop-
down box.

2.  From the All MeetingPlace Attributes scroll-down box, select 
the MeetingPlace attribute.

3.  From either the All LDAP Server Attributes or All Active 

Directory Server Attributes scroll-down box, select the  

attribute you want to map.

4.  Verify the proper attribute mapping is listed in the Build 

Attribute Expression field.

5.  Click Add Mapping.

6.  Repeat the above steps until all preferred attributes are 

mapped.
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7.  

To delete a correlation rule:

1.  From the Correlation Rules screen, select the correlation rule 

that you want to delete from the Correlation Rules drop-down 

box. 

2.  Click Delete.

To delete an attribute mapping from a correlation rule:

1.  From the Correlation Rules screen, select the correlation rule 

that you want to modify from the Correlation Rules drop-
down box. 

3

33
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2.  From the Attribute Mappings box, select the attribute 

mapping you want to delete.

3.  Click Delete.

If you need assistance with creating and managing correlation 

rules, contact your MeetingPlace Support representative.

Using a Plug-In Function

In attribute mapping, a plug-in function allows you to manipulate 

the value of an attribute so that it can be assigned to its mapped 

attribute. MeetingPlace Directory Services comes with several 
plug-in functions that allow you to:

• Extract, append or replace attributes 

• Concatenate attributes

• Assign random attribute values 

• Filter attribute values

The standard plug-in function syntax is &fn(att, [par]), where 

• fn is the function name  

• att is the attribute 

• par is the optional or required parameter

For example, the StringRight plug-in function allows you to 

retrieve a substring after the first occurence of a specified 

character. This particular function recognizes the first occurence 

of the specified character is from the right. So, you could obtain 
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the last 4 digits of a user’s phone number and assign its value to 

the MeetingPlace extension attribute. The attribute mapping for 
this task might appear as:

ExtensionNumber = &StringRight(Phone Number, "-") 

This example states that the extension number attribute of the 

MeetingPlace profile will be synchronized with the value of the 

characters after the first occurence of the "-", from the right, of 
the phone number attribute. So, if an entry on your corporate 

directory has a ’770-649-1865’ phone number value, ’1865’ will 
become the MeetingPlace profile extension number value. Of 
course, the MetaLink agreement, which should include other 
meaningful attribute mappings to ensure the correct entries are 

synchronized, must be run before synchronization will occur.

To use a plug-in function, it must be registered in the 

configuration file. The standard syntax for registering a plug-in 

function is Plug-InFunction = Library, EntryPoint, [OptPar], 
where

• Plug-InFunction is the name of the plug-in function

• Library is the name of the shared library that contains the 

function

• EntryPoint is the name of the entry point to the function in 

the shared library

• OptPar is the optional parameter, a literal string, that will be 

passed to the function each time it is called

Chapter 6 details the process of registering and using plug-in 

functions. For a list of plug-in functions and their optional and 

required parameters, entry points, and libraries, see Appendix B.
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Using a Configuration File

A configuration file stores the correlation rules and attribute 

mappings that define a MetaLink agreement. Figure 5-1 provides 

a sample configuration file sample that displays both standard 

and BootStrap attribute mappings. The configuration file 

parameters most important to MeetingPlace Directory Services 

are discussed in detail on page 49. 

Figure 5-1  Sample configuration file

MeetingPlace Directory Services offers you two ways to modify 

the configuration file to meet the needs of your MetaLink 

agreement. You can either use the MeetingPlace Directory 

Services Admin Tool or manually edit the configuration file. The 

following section provides you with information on how to 

decide which method to use when creating the MetaLink 

agreements. 
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When you create the initial MetaLink agreement between the 

MeetingPlace server and the MeetingPlace Directory Services, 
you use the meetingplace.cfg file, which has most of the 

parameters needed to enable this agreement already mapped for 
you. Since this agreement requires little modification, you should 

use the MeetingPlace Directory Services Admin Tool to 

configure the agreement. This agreement should be configured 

and run before creating any additional agreements.

Once this MetaLink agreement runs and the profiles are imported 

into MeetingPlace Directory Services, you must create an 

agreement between the MeetingPlace Directory Services server 
and your corporate directory server. 

If your coporate directory server has less than 50,000 entries, you 

should use the MeetingPlace Directory Services Admin Tool. If 
your corporate directory server has more than 50,000 entries, you 

should modify the configuaration file manually to configure the 

MetaLink agreement. 

Currently, MeetingPlace Directory Services provides default 
configuration files for both Netscape LDAP and Microsoft Active 

Directory servers. These default configuration files provide some 

sample parameters to create the agreement between MeetingPlace 

Directory Services and your corporate directory server. You 

should examine your business rules to determine which attributes 

and rules will work best to enable this agreement. If you need 

assistance, contact your MeetingPlace Support representative.

Table 5-1 lists the default configuration files used to create the 

MetaLink agreement between the MeetingPlace Directory 

Services server and your corporate directory server. The default 
configuration files can be found in X:\Program 

Files\Latitude\MeetingPlace Directory Services 

Gateway\DSG Admin, where X: refers to the drive where the 

MeetingPlace Directory Services software was installed (this 

assumes you accepted all the default values during installation). 
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Table 5-1  Default MetaLink agreement configuration files

As you create new MetaLink agreements, you can specify an 

existing configuration file as the source file. The source 

configuration file will already have attribute mappings and 

correlation rules defined (as stored in the configuration file), 
which can be edited to create a new agreement. Regardless of 
which method you use to create the MetaLink agreement, using 

an existing configuration file can alleviate you from having to 

define all of the parameters of the agreement. The destination 

configuration file will store the updated parameters that were 

created as a result of the modifications made to the source 

configuration file.

Since you can use the same configuration file more than once, 
you should consider a meaningful naming convention. This may 

assist you in specifying the proper source file when creating a 

MetaLink agreement. 

Select if your corporate directory 

server is

ldap.cfg Netscape LDAP

AD.cfg Microsoft Active Directory
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Configuration File Structure

Once you understand the configuration file structure, you can 

modify it to create a MetaLink agreement. Table 5-2 displays the 

parameters of a configuration file that are necessary to create a 

MetaLink agreement.

Parameter Description Example

LDAPFilters A condition to filter 
out entries based on 

attributes.

Abs_Person = 

%attrHasValue(*objectClass, "person")

DCDPersonMapping Allows you to 

register standard 

and BootStrap 

attribute mappings 

and correlation 

rules. You must 
register mappings 

and rules before you 

can utilize them.

StandardMapping = ImportPersonMap

ImportCorrelation The default 
correlation rule 

which can be 

modified to include 

additional attribute 

mappings

fullDistName = "/o=yourcompany.com/
ou=people/nm=""" + uid + """

ConversionFunctions Allows you to 

register plug-in 

functions so that 
you can apply them 

to standard and 

BootSrap attribute 

mappings.

attrHasValue = 

dcmlkcnv.dll,mlkAMapAttrHasValue

LDAPObjectClass A list of classes that 
will be mapped.

LDAPPerson = 

top,person,inetOrgPerson,organizationPer
son,yourcompanyOrgPerson

BootStrapPersonMap A list of BootStrap 

attribute mappings.
FirstName = givenname
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Table 5-2  Configuration File Parameters

MetaLink Management Utility Script

Once a MetaLink agreement is configured, a MetaLink 

Management Utility (mmu) script is created and must be run to 

enable the agreement. The mmu script stores parameters that 
determine how and when the agreement will run, and against 
which servers the agreement will run. Figure 5-2 displays a 

sample MetaLink Management Script.

Figure 5-2  Sample mmu script

By default, MeetingPlace Directory Services names the mmu 

scripts between the MeetingPlace Directory Services server and 

your corporate directory server as:

• ld.mmu – used for Netscape LDAP  

• ad.mmu – used for Microsoft Active Directory

The default mmu scripts can be found in X:\Program 

Files\Latitude\MeetingPlace Directory Services 

Gateway\DSG Admin, where X: refers to the drive where the 

ImportPersonMap A list of standard 

attribute mappings.
LastName = sn 

Parameter Description Example
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MeetingPlace Directory Services software was installed (this 

assumes you accepted all the default values during installation). 

MMU Script Structure

The mmu script parameters that are most important to 

understand, and those that may need to be modified by you are 

described in Table 5-3. 

Parameter Description Example

AgreementScope In MeetingPlace Directory 

Services, the subtrees that 
entries will be imported into.

/o=yourcompany.com/ou=people

ConfigRecord The path of the configuration 

file.
@C:\DSGAdmin\CFG\ldap01.cfg

NSHostName The hostname of the 

corporate directory server.
sixsmith.piedmont.com

UserName The user name used to log 

onto the local machine.
cn=Sheryl

Password The password of the user 
name used to log onto the 

local machine.

password

LDAPSubtree The path that will export the 

entries into MeetingPlace 

Directory Services.

ou=people, o=yourcompany.com

SuspensePath The path of the suspense file. c:\temp\suspense

UIDAttr The name of the invariant 
attribute used to uniquely 

identify each entry in the 

corporate directory server.

uid

LDAPTimeOut The amount of time, in 

seconds, MeetingPlace 

Directory Services will wait 
to receive a response from 

the corporate directory 

server.

36000
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Table 5-3  MetaLink Management Utility Script Parameters

Viewing a Suspense File
A suspense file is created to log any errors that occur when a 

MetaLink agreement is run. It provides details of the failed 

exchange, the time of the failure, the name of the entry that could 

not be created, updated, or deleted, and a brief description of the 

failure.

By default, MeetingPlace names the suspense files created for the 

agreement between the MeetingPlace server and the 

MeetingPlace Directory Services server as:

• MPML Import – records activity imported into 

MeetingPlace Directory Services from the MeetingPlace 

server.

• MPML Export – records activity exported from the 

MeetingPlace Directory Services server into the 

MeetingPlace server.

PortNumber The port number that will 
tunnel information to 

MeetingPlace Directory 

Services.

389

Parameter Description Example
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The following syntax is used to name suspense files:

xaaaaaa-yyyymmddhhmm.nnn, where

• x is the character "I" for import or "E" for export

• aaaaaa is the ID for the failed agreement

• yyyymmdd is the date the suspense file was created

• hhmm is the local time the suspense file was created

• nnn is an extension to differentiate files created at the same 

time (starts at "001")

A suspense file can be replayed in an attempt to re-synchronize 

the failed entries, and ensure that the information held in the 

MeetingPlace Directory Services servers is up to date. Before 

you replay a suspense file, you should view it, and any errors that 
you want to correct should be resolved on the appropriate server 
(MeetingPlace server or your corporate directory server). Once 

you have corrected the desired errors, you can replay the suspense 

file. 

To replay a suspense file from the command prompt, type the 

following:

dcdrepl <filename>, where filename is the name of the 

suspense file to be replayed.

On a successful replay, the suspense file is automatically deleted. 
If synchronization should fail during a replay, then an additional 
suspense file is generated. 

Although it is not necessary to replay a suspense file, they should 

be replayed in the order they were created because the problem 

may automatically correct itself on a subsequent synchronization. 
Alternatively, if there is a problem with the details of a particular 
entry, and several updates have been made to it, then there may 
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be several suspense files reporting errors with this entry. In this 

case, only one suspense file corresponding to this entry needs to 

be replayed to re-establish synchronization.

Backing Up Your Work
It is advisable to make periodic backups of the directory 

information in case of hardware failure or corruption. The backup 

can subsequently be restored so as to minimize the loss of data. 
Additionally, if you are about to make large scale changes to the 

directory, it is prudent to make a backup copy before making any 

changes. If a problem occurs, you can restore the directory to its 

previous state.

It is recommended that you perform backups at the same time and 

frequency as you perform your MeetingPlace server backup. If 
you are uncertain of when the MeetingPlace server backup 

occurs, or if you do not back up the MeetingPlace server, you 

should back up the directory information once a week to ensure 

restoration of the directory in case of catastrophic loss.

Backing up the Directory

To perform a backup from a command prompt, type the 

following:

dcbckdib BACKUP <backup directory>
[THRESHOLD] <threshold-in-Kb>], where <backup
directory> is the directory you want to store the backup in. 

dcbcklib will create this directory and place the backup in a 

subdirectory beneath it.

Before backing up the directory, dcbckdib will check to make 

sure there is sufficient space to store the backup copy of the 

directory.
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• If the THRESHOLD parameter is present, dcbckdib will 
ensure that the backup partition contains at least <threshold-
in-Kb> + <maximum-size-of-back-up> disk space.

• If the THRESHOLD parameter is not present, dcbckdib will 
ensure that the backup partition contains at least twice the 

<maximum-size-of-back-up> disk space.

The exact size of the compressed data with the original 
uncompressed data depends on the particular directory 

information being backed up. To prevent running out of disk 

space, <maximum-size-of-back-up>, is calculated as the size of 
the uncompressed database.

dcbckdib will pause the server while it performs a backup. 
This ensures that the backup will reflect a consistent state of the 

directory. If the backup fails immediately, because there is not 
enough disk hspace, either delete unwanted files or choose a 

directory on a different drive before proceeding with the backup.

Automating the Backup Process

You can take advantage of the Windows Task Scheduler function 

to schedule automatic backups. This process requires Microsoft 
Internet Explorer version 5.0 or later. Automating the backup 

process involves:

• Creating a batch file – general instructions on how to create a 

batch file to back up the directory.

• Scheduling the process – using Windows Task Scheduler to 

automate the backup process
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The following instructions on creating a batch file include 

commands for deleting an existing back up file, moving the back 

up file to a different directory, and creating the batch file. The 

first two commands execute only if a backup file already exists. 
These commands are necessary to update and delete the file so 

there are no duplicate copies of the backup, and to ensure that this 

the backup process is performed automatically.

To create a batch file:

1.  From Start | Programs | Accessories, select Notepad.

2.  Type the following syntax:

del X:\directory\filename
move X:\directory\subdirectory\filename
X:\directory
dcbckdib backup X:directory\subdirectory,
where 

• directory is the root directory you specify

• subdirectory is the subdirectory that the dcbcklib 

command places the backup copy in

• filename is the name of the backup file. 

To schedule the automation process in Windows Task 

Scheduler:

1.  Right-click the Start menu and select Explore.

2.  From the All Folders panel, select the Scheduled Tasks 

folder.

3.  From the Contents of Scheduled Tasks panel, double-click 

Add Scheduled Task.
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4.  Click Next.

5.  Select the application that will run the batch file.

6.  Click Browse to select the batch file. Click Open.
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7.  From the Perform This Task options, select the frequency at 
which you want the automatic backup to occur. Click Next.

8.  Select the frequency parameters and click Next.
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9.  Enter the NT logon user name, password, and password 

confirmation in the fields provided. Click Next.

10. Click Finish.
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Restoring a backup copy of the database

It may be necessary to restore a backup copy of the directory if a 

serious failure occurs resulting in data loss, or if a large update 

has ended in error and the previous state of the directory needs to 

be restored.

The server must be stopped to restore the directory information. 
Once you have stopped the server, from a command prompt, type 

the following:

dcbckdib RESTORE <backup directory>, where 

<backup directory> is the name of the directory you want 
to restore. If there is an existing directory, you will be prompted 

for confirmation to delete it and replace it with the restored copy.

The time it takes to perform and restore a backup depends on:

• The size of the directory

• The speed of the server’s processor and hard disk

• Whether the back up directory is on a local or remote drive

Now that you have an understanding of the MetaLink agreement 
parameters, you should create the agreements between 

MeetingPlace and your corporate directory server. 
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6 Creating a MetaLink 
Agreement 

Now that you have learned which parameters comprise a 

MetaLink agreement, it is now time to create an agreement. This 

chapter provides you with the following information:

• Preparing for the creation of a MetaLink agreement

• Creating a MetaLink agreement

• Testing a MetaLink agreement

Preparing for the creation of a MetaLink agreement

Before you create the first MetaLink agreement, you should 

create a directory for the admin node. This directory will store the 

imported data from the MeetingPlace server and your corporate 

directory server.

To create a directory:

1.  From Start | Programs, select DC Directory Administrator.

2.  From the Log on to DC Directory Admin – step 1 of 2 screen, 
click Next.

3.  From the Log on to DC Directory Admin – step 2 of 2 screen, 
enter the user name and password. Click Finish.

4.  From the DC Directory Admin screen, right-click the admin 

node from the left panel and select New. 

5.  Select Organizational Unit.
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6.  From the Add New Organizational Unit screen, enter the 

directory name and click OK.

7.  From the DC Directory Admin screen, click the File menu 

and select Exit.

Now that you have created a directory, you should create the 

initial MetaLink agreement between the MeetingPlace server and 

the MeetingPlace Directory Services server.
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Creating a MetaLink Agreement 
A MetaLink agreement creates, updates and deletes MeetingPlace 

profiles based on attribute mappings and correlation rules 

established between two servers. The topics covered in the 

following section include:

• Creating a MetaLink agreement between the MeetingPlace 

server and the MeetingPlace Directory Services server

• Creating a MetaLink agreement between the MeetingPlace 

Directory Services server and your corporate directory server

Creating a MetaLink agreement between the MeetingPlace server 
and the MeetingPlace Directory Services server

You should allow this initial MetaLink agreement to run before 

creating and running the MetaLink agreement between the 

MeetingPlace Directory Services server and the corporate 

directory server. 

To create a MetaLink agreement between the MeetingPlace 

server and the MeetingPlace Directory Services server:

1.  From Start | Programs | MeetingPlace Applications | 
MeetingPlace Directory Services, select DSG Admin.

2.  From the Customer Database Type screen, select 
MeetingPlace. Click Next.
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3.  From the MeetingPlace Directory screen, enter the

Server Name - the hostname or IP address of the 

MeetingPlace Directory Services server.

User DN - written in LDAP format, this is a combination of 
the admin node and user name created during Installing the 

MeetingPlace Directory Services, steps 9 and 18. 

Password - this is the password created during Installing the 

MeetingPlace Directory Services, step 19. 

Port Number - typically, this is port 389.

4.  Click Next. 
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5.  From the Browse MP Directory screen, click the admin node 

to expand the MeetingPlace directory tree. Select the 

directory that will store the directory information. Click Next.

6.  From the MMU Script Path screen, click Browse.

7.  From the Save As screen, enter the name of the mmu script in 

the File name field. Click Save.
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8.  From the MMU Script Path screen, click Next to run the 

MetaLink agreement.

Once the MetaLink agreement is run, you can expect the 

MeetingPlace profiles to propagate the MeetingPlace Directory 

Services server at a rate of about one profile per second. 

Creating a MetaLink agreement between the MeetingPlace 
Directory Services server and your corporate directory server

MeetingPlace Directory Services offers you a couple of ways to 

create a MetaLink agreement between the MeetingPlace server 
and your corporate directory server. You can use the 

MeetingPlace Directory Services Admin Tool or modify a 

configuration file to create the agreement. 

Since the MeetingPlace Directory Services Admin Tool has to 

verify all of the entries on the subtree you are importing into 

MeetingPlace, using this tool can be a time-consuming process. 
The number of entries that you want to import into MeetingPlace 

from your corporate directory server will determine which 

process is best for you.

A general rule is that if you have less than 50,000 entries on your 
corporate directory server, you should use the MeetingPlace 

Directory Services Admin Tool. If you have more than 50,000 

entries, it is recommended that you modify the default 
configuration file and run the mmu script manually.
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The following section provides you with information on:

• Using the MeetingPlace Directory Services Admin Tool

• Modifying the Configuration File

• Modifying the MMU Script

Using the MeetingPlace Directory Services Admin Tool

As previously discussed, you should use the MeetingPlace 

Directory Services Admin Tool if you have less than 50,000 

entries on your corporate directory server. The following sections 

detail how to use the tool to create a MetaLink agreement for both 

Netscape LDAP and Microsoft Active Directory servers.

To create a MetaLink agreement between the MeetingPlace 

Directory Services server and your corporate Netscape LDAP 

server using the MeetingPlace Directory Services Admin 

Tool:

1.  From Start | Programs | MeetingPlace Applications | 
MeetingPlace Directory Services, select DSG Admin.

2.  From the Customer Database Type screen, select LDAP.

3

33
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3.  From the Source .cfg file field, click Browse. 

4.  If this is the initial agreement between the two servers,   
select ldap.cfg from the Open window and click Open.

If this is not the initial agreement, select the source 

configuration file from the Open window and click Open.



Chapter 6  Creating a MetaLink Agreement 69

Latitude Communications MeetingPlace Directory Services System Manager’s Guide

5.  From the New .cfg file field, click Browse. 

6.  If this is the initial agreement between the two servers, 
perform the following steps:

• Select ldap.cfg and click Open. 

• Place your cursor at the end of the new configuration file 

name, before the file extension (.cfg). 

• Append the new configuration file with "01" to 

distinguish it from the source configuration file. This new 

file, ldap01.cfg, will contain the parameters of the 

MetaLink agreement you are now creating. 

• Click Next.

If this is not the initial agreement, append the configuration 

file with a number that will logically define the MetaLink 

agreement.
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7.  From the Specify Server screen, enter the following 

information under the LDAP Server box:

Server Name - the hostname or IP address of the LDAP 

corporate directory server.

User DN - written in LDAP format, the user name to access 

your corporate directory server. 

Password - the password for the above user name.

Port Number - the default value is 389.

8.  From the Specify Server screen, enter the following 

information under the MeetingPlace Directory box:

Server Name - the hostname or IP address of the 

MeetingPlace Directory Services server.

User DN - written in LDAP format, this is a combination of 
the admin node and user name created during Installing the 

MeetingPlace Directory Services, steps 9 and 18. 

Password - this is the password created during Installing the 

MeetingPlace Directory Services, step 19. 

Port Number - the default value is 389.
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9.  From the Tree Mapping screen, perform the following steps:

• From the LDAP Server Tree box, select the subtree on 

the LDAP server that stores the directory information 

you want to import into MeetingPlace Directory 

Services. 

• From the MeetingPlace Directory Tree box, click the 

admin node to expand the directory. Select the subtree 

that will store the LDAP directory information.

• Verify that the proper LDAP and MeetingPlace subtrees 

are displayed in the Directory Mapping box.

• Click Next.

10. Wait while MeetingPlace Directory Services verifies the 

entries on the specified subtree.
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11.  By default, standard object classes are mapped in the 

configuration file. If you created a customized class, it will 
appear in the Unmapped LDAP Server Classes box and 

should be mapped manually.

From the Class Mapping screen, perform the following steps:

• From the Unmapped Active Directory Server Classes 

box, select the class.

• Click Add Mapping.

• Repeat these steps until all classes are mapped.

• Click Next.
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12. From the BootStrap Attribute Mapping screen, perform the 

following steps:

• From the MeetingPlace Attributes box, select the 

attribute you want to use for BootStrap attribute 

mapping. 

• From the LDAP Server Attributes box, select the 

corresponding attribute that will be mapped to the 

MeetingPlace attribute. 

• Verify the proper attributes are listed in the Mapping 

Expression field.

• Click Add Mapping.

• Repeat these steps until all desired attributes are mapped.

• Click Next.
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13. From the Attribute Mapping screen, perform the following 

steps:

• From the MeetingPlace Attributes box, select the 

attribute you want to use for attribute mapping. 

• From the LDAP Server Attributes box, select the 

corresponding attribute that will be mapped to the 

MeetingPlace attribute.

• Verify the proper attributes are listed in the Mapping 

Expression box.

• Click Add Mapping.

• Repeat these steps until all desired attributes are mapped.

• Click Next.
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14. From the Correlation Rules screen, select the rule from the 

Correlation Rules drop-down list, and click Next.

Instructions on how to add, modify and delete a correlation 

rule using the MeetingPlace Directory Services Admin Tool 
are provided on page 42. 

15. From the MMU Script Path screen, click Browse.
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16. From the Save As screen, enter the name of the mmu script in 

the File name field. Click Save.

17. From the MMU Script Path screen, click Next to run the 

MetaLink agreement.

Once the MetaLink agreement is run, you can expect the entries 

to propagate the MeetingPlace Directory Services server at a rate 

of about one profile per second. 



80 Chapter 6  Creating a MetaLink Agreement 

MeetingPlace Directory Services System Manager’s Guide Latitude Communications

To create a MetaLink agreement between the MeetingPlace 

Directory Services server and the corporate Microsoft Active 

Directory server using the MeetingPlace DSG Admin Tool:

1.  From Start | Programs | MeetingPlace Applications | 
MeetingPlace Directory Services, select DSG Admin.

2.  From the Customer Database Type screen, select Active 

Directory.

3.  From the Source .cfg file field, click Browse. 
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4.  If this is the initial agreement between the two servers,   
select AD.cfg from the Open screen and click Open.

If this is not the initial agreement, select the source 

configuration file from the Open screen and click Open.

5.  From the New .cfg file field, click Browse. 
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6.  If this is the initial agreement between the two servers, 
perform the following steps:

• Select AD.cfg and click Open. 

• Place your cursor at the end of the new configuration file 

name, before the file extension (.cfg). 

• Append the new configuration file with "01" to 

distinguish it from the source configuration file. This new 

file, AD01.cfg, will contain the parameters of the 

MetaLink agreement you are now creating. 

• Click Next.

If this is not the initial agreement, append the configuration 

file with a number that will logically define the MetaLink 

agreement.

7.  From the Specify Server screen, enter the following 

information under the Active Directory Server box:

Server Name - the hostname or IP address of the Active 

Directory corporate directory server.

User DN - written in LDAP format, the user name to access 

the corporate directory. 

Password - the password for the above user name.

Port Number - the default value is 389.
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8.  From the Specify Server screen, enter the following 

information under the MeetingPlace Directory box:

Srver Name - the hostname or IP address of the MeetingPlace 

Directory Services server.

User DN - written in LDAP format, this is a combination of 
the admin node and user name created during Installing the 

MeetingPlace Directory Services, steps 9 and 18. 

Password - this is the password created during Installing the 

MeetingPlace Directory Services, step 19. 

Port Number - the default value is 389.
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9.  From the Tree Mapping screen, perform the following steps:

• From the Active Directory Server Tree box, select the 

subtree on the server that stores the directory information 

you want to import into MeetingPlace Directory 

Services. 

• From the MeetingPlace Directory Tree box, click the 

admin node to expand the directory. Select the subtree 

that will store the Active Directory information.

• Verify that the proper Active Directory and MeetingPlace 

subtrees are displayed in the Directory Mapping box.

• Click Next.

10. Wait while MeetingPlace Directory Services verifies the 

entries on the specified subtree.
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11.  By default, standard object classes are mapped in the 

configuration file. If you created a customized class, it will 
appear in the Unmapped Active Directory Server Classes box 

and should be mapped manually.

From the Class Mapping screen, perform the following steps:

• From the Unmapped Active Directory Server Classes 

box, select the class.

• Click Add Mapping.

• Repeat these steps until all classes are mapped.

• Click Next.
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12. From the BootStrap Attribute Mapping screen, perform the 

following steps:

• From the MeetingPlace Attributes box, select the 

attribute you want to use for BootStrap attribute 

mapping. 

• From the Active Directory Server Attributes box, select 
the corresponding attribute that will be mapped to the 

MeetingPlace attribute. 

• Verify the proper attributes are listed in the Mapping 

Expression box.

• Click Add Mapping.

• Repeat these steps until all desired attributes are mapped.

• Click Next.
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13. From the Attribute Mapping screen, perform the following 

steps:

• From the MeetingPlace Attributes box, select the 

attribute you want to use for attribute mapping. 

• From the Active Directory Server Attributes box, select 
the corresponding attribute that will be mapped to the 

MeetingPlace attribute.

• Verify the proper attributes are listed in the Mapping 

Expression box.

• Click Add Mapping.

• Repeat these steps until all desired attributes are mapped.

• Click Next.
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14. From the Correlation Rules screen, select the rule from the 

Correlation Rules drop-down list, and click Next.

Instructions on how to add, modify and delete a correlation 

rule using the MeetingPlace Directory Services Admin Tool 
are provided on page 42. 

15. From the MMU Script Path screen, click Browse.
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16. From the Save As screen, enter the name of the mmu script in 

the File name field. Click Save.

17. From the MMU Script Path screen, click Next to run the 

MetaLink agreement.

Once the MetaLink agreement is run, you can expect the entries 

to propagate the MeetingPlace Directory Services server at a rate 

of about one profile per second. 

Modifying a Configuration File
As previously discussed, you should modify a configuration file 

to create a MetaLink agreement if your corporate directory server 
has more than 50,000 entries. A configuration file is a text file, so 

you can modify it using any text editor. The following section 

provides information on how to modify a configuration file so 

that you can create an agreement. For additional information, 
refer to Table 5-2.
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LDAP Filters

The LDAP Filters section of the configuration file contains a list 
of objects you want to import. By default, MeetingPlace 

Directory Services imports all entries whose objectClass 

attribute has a value of person, as detailed in the
[LDAPFilters] section of the configuration file:

[LDAPFilters]
Abs_Person = &attrHasValue(*objectClass,
“person”)

You can modify an existing LDAP filter to include additional 
attributes.

To modify the LDAPFilter expression to include additional 
attributes:

1.  From the [Conversion Functions] section, enter the 

following expression:

FilterAnd = MPPlugIn.dll, mlkFilterAnd

In order to filter on multiple values, the filters must be 

appended to one another. This command registers the 

FilterAnd function, which allows you to append an 

expression, and can be used to filter out more than one 

attribute. To utilize a plug-in function, it must be registered.

2.  From the [LDAPFilters] section of the configuration 

file, alter the expression to appear as:

Abs_Person = &filterAnd(“2”,
&attrHasValue(*objectClass, “person”,
&attrHasValue(*attribute name, “attribute
value”), where 

• attribute name is the name of the attribute

• attribute value is the filter

3.  From the File menu, click Save.
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Correlation Rules

Once the MetaLink agreement determines which entries will be 

imported, it then uses correlation rules to determine if that entry 

already exists on MeetingPlace. If the entry does exist, it will use 

standard attribute mapping to perform the update based on the 

information retrieved from the corporate directory server. If the 

entry does not exist, a new entry will be created using BootStrap 

attribute mapping.

You can modify the default correlation rule to include additional 
attribute mappings and/or add a new correlation rule.

To modify a correlation rule:

1.  From the [ImportCorrelation] section, enter the 

attribute mapping under the section header.

2.  From the File menu, click Save.

To add a correlation rule:

1.  From the [DCDPersonMapping] section, enter the name 

of the new correlation rule on the CorrelationRules 

field. All correlation rules should be separated by a comma.

For example, if you want to add a new correlation rule, 
ImportCorrelation01, to the default configuration file, 
the [DCDPersonMapping] section might look like the 

following:

[DCDPersonMapping]
StandardMapping = ImportPersonMap
BootstrapMapping = BootStrapPersonMap
CorrelationRules = ImportCorrelation,
ImportCorrelation01

2.  After the ImportCorrelation section, enter a new 

section entitled, ImportCorrelation01.

[ImportCorrelation]
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fullDistName=”/o=yourcompany.com/
ou=people/nm=" " " + uid + " " " "
[ImportCorrelation01]

3.  Enter the attribute mapping(s) that will make up this 

correlation rule.

4.  From the File menu, click Save.

BootStrap Attribute Mapping

As previously discussed, BootStrap attribute mapping is used 

when entries are first imported into MeetingPlace. In the 

configuration file, you can add, modify, and delete BootStrap 

attribute mappings to ensure that the MetaLink agreement meets 

the needs of your organizational directory information.

To add a BootStrap attribute mapping:

1.  From the [BootStrapPersonMap] section, add the 

attribute mapping you want to become part of BootStrap 

attribute mapping.

2.  Repeat step 1 until all desired attributes have been modified.

3.  From the File menu, click Save.

To modify a BootStrap attribute mapping:

1.  From the [BootStrapPersonMap] section, modify the 

attribute mapping.

2.  Repeat step 1 until all desired attributes have been mapped.

3.  From the File menu, click Save.
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To delete a BootStrap attribute mapping:

1.  From the [BootStrapPersonMap] section, highlight the 

attribute mapping you want to delete.

2.  From your keyboard, press the Delete key.

3.  Repeat steps 1 and 2 until all desired attribute mappings have 

been deleted.

4.  From the File menu, click Save.

Standard Attribute Mapping

Standard attribute mapping applies to those entries that have 

already been imported into MeetingPlace Directory Services and 

will be updated during synchronization. In the configuration file, 
you can add, modify or delete a standard attribute mapping to 

ensure that the MetaLink agreement meets the needs of your 
organizational directory information.

To add a standard attribute mapping:

1.  From the [ImportPersonMap] section, add the attribute 

mapping.

2.  Repeat step 1 until all desired attributes have been mapped.

3.  From the File menu, click Save.

To modify a standard attribute mapping:

1.  From the [ImportPersonMap] section, modify the 

attribute mapping.

2.  Repeat step 1 until all desired attributes have been modified.

3.  From the File menu, click Save.
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To delete a standard attribute mapping:

1.  From the [ImportPersonMap] section, highlight the 

attribute mapping you want to delete.

2.  From your keyboard, press the Delete key.

3.  Repeat steps 1 and 2 until all desired attribute mappings have 

been deleted.

4.  From the File menu, click Save.

Plug-In Functions

Before you can use a plug-in function, you must register it.For 
additional information, refer to page 50 and page 114.

To register a plug-in function:

1.  From the [Conversion Functions] section, enter the 

plug-in function. 

2.  From the File menu, click Save.

To use a plug-in function:

1.  From the section you want to apply the plug-function 

[BootStrapPersonMap], [ImportPersonMap], 
or [ImportCorrelation], type the function so that it 
appears before the attribute.

A list of plug-in functions, their optional and required 

parameters, entry points and libraries is provided in 

Appendix B.

2.  From the File menu, click Save.

Modifying the MMU Script
Before you run the mmu script, you may need to modify its 

parameters to enable the MetaLink agreement. The mmu script is 

a text file, so you can modify it using any text editor. For 
additional information, refer to Table 5-3.
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To modify the mmu script:

1.  From Start | Programs | Windows Explorer, select the drive 

you installed MeetingPlace Directory Services on.

2.  From Latitude | MeetingPlace Directory Services | DSG 

Admin, double-click:

• ld.mmu if your corporate directory server runs Netscape 

LDAP

• ad.mmu if your corporate directory server runs 

Microsoft Active Directory 

3.  Modify the AgreementScope line so that it reflects the 

local path entries will be imported into.

4.  Modify the ConfigRecord line so that it reflects the 

proper path of the configuration file.

5.  Modify the NSHostName line so that it reflects the 

hostname or IP address of your corporate directory server.

6.  Modify the UserName line so that it reflects the log on user 
name.

7.  Modify the Password line so that it reflects the proper 
password for the above user.

8.  Modify the LDAPSubtree line so that it reflects the path 

that will export entries to MeetingPlace Directory Services.

9.  Modify the SuspenseFile path so that it reflects the path 

that will store the suspense file.

10. Modify the UIDAttr line so that it reflects that attribute that 
will uniquely identify each entry.

11.  Modify the LDAPTimeOut line so that it reflects that 
amount of time, in seconds, you want the MeetingPlace 
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Directory Services server to wait to receive activity from the 

corporate directory server.

12. Modify the PortNumber line so that it reflects the port 
number that is responsible for tunneling information.

Once you have modified the mmu script, you can manually run it 
to enable the MetaLink agreement.

To manually run the mmu script:

1.  From a command prompt, type the following command:

dcdmmu PROCESS <filename>, where filename is 

the name of the mmu script.

2.  From your keyboard, press the Enter key to run the command.

Testing the MetaLink Agreement
You should know how many MeetingPlace profiles and entries 

from your corporate directory server should have propagated to 

MeetingPlace Directory Services. You can verify the number of 
profiles and entries that did propagate by using the DC Directory.

To verify how many entries propagated to MeetingPlace 

Directory Services:

1.  From Start | Programs, select DC Directory Administrator.

2.  From the Log on to DC Directory Admin – step 1 of 2 screen, 
click Next.

3.  From the Log on to DC Directory Admin – step 2 of 2 screen, 
enter the user name and password. Click Finish.
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4.  From the DC Directory Admin screen, verify the entries have  

propagated to MeetingPlace Directory Services by viewing 

the number at the bottom of the screen. 

Once you tested the MetaLink agreement, you should:

• View the suspense file for errors (see page 52).

• Back up the directory (see page 54).
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7 Troubleshooting 
MeetingPlace Directory 
Services 

This chapter explains how to troubleshoot problems that may 

occur after installing MeetingPlace Directory Services and 

running the MetaLink agreements. The topics in this chapter 
include:

• What to do First – provides information on the first things to 

check if you notice problems

• Resolving Connectivity Issues – provides information on 

how to resolve connectivity issues between MeetingPlace 

and your corporate directory

• Resolving MetaLink Agreement Errors – provides 

information on how to correct errors that occure as a result of 
running a MetaLink agreement

• Resolving LDAP ChangeLog Issues – provides information 

on what to do if the LDAP ChangeLog is reset

What to do First

If you experience any problems, perform the following steps to 

make sure MeetingPlace Directory Services has not lost its 

connection to the MeetingPlace server. If you experience the 

same problem after performing these steps, refer to the other 
troubleshooting topics in this chapter.
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Verify the MeetingPlace Directory Services services are 

running:

1.  From the MeetingPlace Directory Services server, go to Start 
| Settings | Control Panel | Services.

2.  Make sure the following services are started:

• MeetingPlace Gateway SIM

• MeetingPlace Directory Server

Verify MeetingPlace Directory Services is logging into the 

MeetingPlace server:

1.  Telnet into the MeetingPlace standalone or network server.

2.  Run GWSTATUS to verify the gateway status is ok.

Check the event logs of the MeetingPlace Directory Services 

server and the MeetingPlace server for any errors relating to 

MeetingPlace.

Resolving Connectivity Issues

If your corporate directory server is not communicating with 

MeetingPlace Directory Services, MeetingPlace profiles will not 
be created, updated or deleted based on the information stored on 

the corporate directory server.

If a MetaLink agreement fails, you should use an LDAP search 

utility to test the connectivity to the LDAP server. If you do not 
have the LDAP search utility, it is downloadable freeware that 
can be obtained from the Internet.

Resolving MetaLink Agreement Errors

Several issues can cause a MetaLink agreement to fail including 

directory overload, duplicate entries, and incongruous attribute 

mappings. If you feel an error has occurred, you should check the 

suspense file.
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You can view the suspense file, correct the error on your 

corporate directory server, and replay the suspense file. 

To replay the file from a command prompt, type the following:

dcdrepl <filename>, where filename is the suspense 

file to be replayed.

Resolving LDAP ChangeLog Issues

If the LDAP Changelog is reset, run the following script. Before 

you begin, it is important to ensure:

• No modifications will take place on the LDAP server until 
you have finished running the script

• LDAP Sync has imported all outstanding changes

• The script is run on the LDAP server

Begin by increasing the period of the LDAP Sync agreement to a 

large value (e.g. an hour) and allow the MetaLink to reread its 

configuration. This assumes you haven’t changed the MetaLink 

configuration reread period, which has a default value of one 

minute.

Update the following script, Admin Node/Hostname/
Agreement ID, where

• Admin node is the admin node of the MeetingPlace 

Directory Services server.

• Hostname is the name of the MeetingPlace Directory 

services server.

• Agreement ID is the ID of the MetaLink agreement.
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For example, if the admin node is /o=yourcompany.com, the 

hostname is eagle and the MetaLink agreement is 1, the DN in the 

first line of the script would be:

/o=yourcompany.com/cn=DCDMLK/cn=eagle/
cn=”LDAP Live Sync Module”/cn=LDAP-Sync-to-
Netscape:1

Copy the script into the run\dcx500\config directory, and run 

cdsadmin resetlog from the command line.

Allow enough time for the MetaLink to reread its configuration 

and then set the period of the LDAP Sync agreement back to its 

original value.

Since the Microsoft Active Directory synchronization, DirSync, 
uses cookies to pass state information between the server and 

client, it is not possible to reset it.

If you need additional assistance, contact your MeetingPlace 

Support representative.

 



Latitude Communications MeetingPlace Directory Services System Manager’s Guide

A Glossary 

Admin Node – In MeetingPlace Directory Services, the top level 
of the directory. For example, o=yourcompany.com or c=us.

Attribute – A property of an object class that describes the 

elements of that object class. For example, the Person object class 

may have attributes such as first name, last name and phone 

number. 

Attribute Mapping – Attribute mapping is used to obtain a set of 
values from an entry in one directory system and set those values 

to an entry in a different system. It is a flexible tool that offers 

many options including concatenating attribute values with other 
attributes and strings, and applying custom mappings and 

conversions to attribute values.

BootStrap Attribute Mapping – A process used to describe how 

attributes are mapped between an organization's directory and the 

MeetingPlace conference server when an entry is first created on 

the MeetingPlace Directory Services server.

Configuration File – A text file, created as a result of attribute 

mapping, that contains information necessary to run a MetaLink 

agreement. The parameters stored in a configuration file include 

which two servers are involved in the agreement and which 

attributes are mapped for correlation and standard 

synchronization.

Correlation – Correlation is used to prevent profiles from being 

duplicated on MeetingPlace. When a profile is imported into 

MeetingPlace for the first time, the correlation process is used to 

locate a matching entry on the organization's directory system. If 
the profile is found, correlation rules can be used to ensure 

attribute values. If a profile is not found, one will be created using 

BootStrap Attribute Mapping.
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Correlation Rule – A correlation rule consists of one or more 

attribute mappings that is responsible for ensuring that no two 

entries are created for the same user. If all of the attributes 

contained in a rule are mapped, then the source and destination 

entries will be correlated. If attribute mapping doesn't occur and 

the entries do not correlate, then a new entry is created.

DC Directory – A MeetingPlace Directory Services graphical 
interface that allows you to create subtrees and view 

MeetingPlace profiles and corporate directory information once 

MetaLink agreements have been run between these servers and 

the MeetingPlace Directory Services server.

Directory Information Tree – In a directory server, a tree-like 

structure whereby each entry is uniquely identified by a 

distinguished name.

Lightweight Directory Access Protocol – Lightweight 
Directory Access Protocol (LDAP) is a standard protocol which 

enables you to locate organizations, individuals, and other 
resources such as files and devices in a network, whether on the 

Internet or on a corporate Intranet.

Live Synchronization – Live Synchronization can be used by the 

MetaLink agreement to update directory information. The 

MetaLink communicates directly with the directory system and 

propagates any changes to MeetingPlace dynamically. MetaLink 

can update changes automatically or through a scheduled event. 
MeetingPlace Directory Services uses live synchronization to 

identify changes in the directory.

MetaDirectory – A single directory infrastructure that helps 

simplify management and administrative task, and gives users 

greater access to information across an organization.

MetaLink Agreement – A MetaLink agreement is an agreement 
between two servers in MeetingPlace Directory Services. An 

agreement consists of attribute mappings and correlation rules 

that defines a Meta-Directory by automatically and dynamically 

synchronizing data. When data changes in an organization's 
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directory the changes are propagated to MeetingPlace by the 

MetaLink, providing a seamless sharing of selected directory 

information.

MetaLink Management Utility Script – A file, created as a 

result of configuring a MetaLink agreement, which must be run 

to enable the agreement.

Plug-In Function – A tool used in correlation and standard 

synchronization that allows you to convert one or more attribute 

values.

Subtree – A branch of the admin node that contains directory 

information to be imported into MeetingPlace.

Suspense File – A text file that contains a list of errors that 
occurred while running a MetaLink agreement.

Synchronization – In a MetaLink agreement, the process of 
synchronizing mapped attributes between two servers. This 

process occurs after the initial import of attributes into 

MeetingPlace and helps to update and delete profiles.
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B MeetingPlace 
Directory Services 
Business Rules

The following table is a list of business rules most commonly 

used for determining which attributes are unique on your 
corporate directory server. You can then effectively map these 

attributes when you create a MetaLink agreement.

MeetingPlace 

Attribute
Potential Source Business Rule

First Name named field in the directory

Last Name named field in the directory

User ID E-mail address

Last name

First name_last name

Employee ID

Random

Password Microsoft Exchange/Lotus 

Notes password

Windows password

Default for all and force a 

change

Random
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Profile ID Phone extension

Employee number

Profile Password Same as user ID password

Microsoft Exchange/Lotus 

Notes password

Default for all and force a 

change

Random

Outdial 
Information

Phone number

Alternate phone number

Pager number

Billing 

Information
Department number

Project code

Group Department number

Division

Title

Location

Randomly assign and use for 
load balancing

Home server Address

Group

Department number

MeetingPlace 

Attribute
Potential Source Business Rule
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E-mail address E-mail address

Timezone Address

Location

Group default

Homesite Address

Department number

Group

Recording 

privileges
Group

Who can access Group

Display meeting 

to all
Group

Oudial privileges Group

Meeting 

preferences
Group

Restrictions Group

MeetingPlace 

Attribute
Potential Source Business Rule
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Notifications Group

Type of e-mail 
system

Group

Q & A Group

MeetingPlace 

Attribute
Potential Source Business Rule
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C MeetingPlace 
Directory Services 
Plug-In Functions

You can use plug-in functions to manipulate the value of an 

attribute when you import it into MeetingPlace. This can be an 

effective tool for attribute mapping as it allows you to:

• Extract, append or replace attributes 

• Concatenate attributes

• Assign random attribute values 

• Filter attribute values

The standard syntax for utilizing a plug-in function is &fn(att), 
where "fn" refers to the function name and "att" refers to the 

attribute. 

Some things to consider when using plug-in functions include:

• VU name = MeetingPlace profile number

• The ASCII code for a backslash, " \ ", is \5C

• Each plug-in function has a pre-defined set of optional and 

required parameters

• A % preceding an attribute means that it must have a value
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The following table lists the plug-in functions available in 

MeetingPlace Directory Services.

Function

Entry Point

Library

Meaning Parameter

attrHasValue

mlkAMapAttrHasValue

dcmlkcnv.dll

returns a non-empty string if a 

match for the attribute is found 

and an empty string if a match is 

not found

attribute, value

Case

mlkAMapCase

dcmlkcnv.dll

one of:

1. AllUpper – converts all 
characters to upper case

2. FirstUpper – converts first 
character to upper case

3. WordUpper – converts first 
character of each word to 

upper case

4. AllLower – converts all 
characters to lower case

5. WordLower – converts all 
characters except the first 
character to lower case

6. FirstNormal – converts the 

first character to upper case 

and remaining characters to 

lower case

7. WordNormal – converts the 

first character of each word to 

upper case and the remaining 

characters to lower case

attribute

FilterAND

mlkFilterAND

MPPlugIn.dll

concatenate 2 or more values n, attribute

a maximum of  9 

attributes can be filtered
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FilterBuiltIn

mlkFilterBuiltIn

MPPlugIn.dll

filter out any entries with an 

attribute equal to a given value
attribute

FilterNOT

mlkFilterNOT

MPPlugIn.dll

invert an expression attribute

Initials

mlkAMapInitials

dcmlkcnv.dll

convert each letter to upper case, 
followed by a dot (.); used to 

initialize normal values

attribute

MapString

mlkStringMap

MPPlugIn.dll

map values with table values in a 

specified file
attribute, directory path

MidString

mlkStringMid

MPPlugIn.dll

obtain a number of characters 

starting from a specified location
attribute, index, count

Random

mlkRnd

MPPlugIn.dll

assign a random number to a 

value 

n, 0 – n

ReparentDN

mlkAMapReparentDN

dcmlkcnv.dll

allows you to change the subtree 

to the DN
existing parent (subtree), 
new parent (subtree)

SingleSpace

mlkAMapSingleSpace

dcmlkcnv.dll

convert multiple consecutive 

space characters to a single 

space character

attribute

String2Number

mlkString2Number

MPPlugIn.dll

convert a string to a number, 
based on a standard phone dial 
pad

attribute

Function

Entry Point

Library

Meaning Parameter
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StringLeft

mlkStringLeft

MPPlugIn.dll

obtain substring before (to the 

left of) a specified character
attribute, " "

StringMidNoEnd

mlkStringMidNoEnd

MPPlugIn.dll

return a substring from a given 

start index 

n, 0-n

StringRight

mlkStringRight

MPPlugIn.dll

obtain substring after (to the 

right of) a specified character
attribute, " "

StringRightN

mlkStringRightN

MPPlugIn.dll

obtain a number of characters 

from the right
attribute, n

TelephoneValidate

mlkAMapTelValidate

dcmlkcnv.dll

remove all characters other than 

‘0’ - ‘9’, ‘ ‘ and ‘+’
attribute

Trim

mlkAMapTrim

dcmlkcnv.dll

remove white space from start to 

end of each value
attribute

Truncate

mlkAMapTruncate

dcmlkcnv.dll

number indicating the maximum 

length of value
attribute

Function

Entry Point

Library

Meaning Parameter
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D MeetingPlace 
Directory Services 
Attributes

The following table lists attributes specific to MeetingPlace  

Directory Services. You can utilize this table to map 

MeetingPlace attributes to corresponding attributes on your 
corporate directory server. 

You can obtain a full list of MeetingPlace attributes from the 

MeetingPlace System Manager’s Guide. 

MeetingPlace Attribute Description Format

MPName The user’s 

MeetingPlace name.
ASCII text – 17 

characters maximum

UserPassword The user’s 

MeetingPlace 

password.

ASCII – 11 characters 

maximum

WFPasswordLastChanged The date and time of 
the last MeetingPlace 

password change for 
this profile.

MM/DD/YYYY 

HH:MM

ProfileNumber The user’s profile 

number.
Numeric – 17 

characters maximum

ProfilePassword The user’s profile 

password.
Numeric – 11 

characters maximum

VUPasswordLastChanged The date and time of 
the last VUI password 

change for this profile.

MM/DD/YYYY 

HH:MM

NetworkCredentials The user’s full network 

name.
ASCII text
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Group Name The user’s group name. ASCII text –  0 to 17

TimeZone The user’s time zone. Integer

FirstName The user’s first name. ASCII text – 17 

characters maximum

LastName The user’s last name. ASCII text – 17 

characters maximum

OutdialPhone The user’s phone. ASCII text – 31 

characters maximum

EmailAdd The user’s e-mail 
address.

Alphanumeric – 127 

characters maximum

BillCode The meeting’s billing 

code.
ASCII text – 0 to 17

UniqueID The user’s internal 
database identifier.

For internal use only.

BootSource The origin of the entry. For internal use only.

UpdateSource The origin of the last 
update.

For internal use only.

Custom1 – Custom10 reserved for future use. ASCII text

MeetingPlace Attribute Description Format
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E MeetingPlace Time 
Zone Codes

This appendix includes the Time Zone Import Codes. There are 

319 time zones to accommodate the rules of each country and 

region. MeetingPlace supports all of these time zones, so users do 

not have to account for time zone differences. 

  0   factory 18  Africa/Dar_es_Salaam 36  Africa/Maputo

  1  local time 19  Africa/Djibouti 37  Africa/Maseru

  2  Africa/Adidjan 20  Africa/Douala 38  Africa/Mbabane

  3  Africa/Accra 21  Africa/Freetown 39  Africa/Mogadishu

  4  Africa/Addis_Ababa 22  Africa/Gaborone 40  Africa/Monrovia

  5  Africa/Algiers 23  Africa/Harare 41  Africa/Nairobi

  6  Africa/Asmera 24  Africa/Johannesburg 42  Africa/Ndjamena

  7  Africa/Bamako 25  Africa/Kampala 43  Africa/Niamey

  8  Africa/Bangui 26  Africa/Khartoum 44 Africa/Nouakchott

  9  Africa/Banjul 27  Africa/Kigali 45  Africa/Ouagadougou

10  Africa/Bissau 28  Africa/Kinshasa 46  Africa/Porto_Novo

11  Africa/Blantyre 29  Africa/Lagos 47  Africa/Sao_Tome

12  Africa/Brazzaville 30  Africa/Libreville 48  Africa/Timbuktu

13  Africa/Bujumbura 31  Africa/Lome 49  Africa/Tripoli

14  Africa/Cairo 32  Africa/Luanda 50  Africa/Tunis

15  Africa/Casablanca 33  Africa/Lubumbashi 51  Africa/Windhoek

16  Africa/Conakry 34  Africa/Lusaka 52  America/Anchorage

17  Africa/Dakar 35  Africa/Malabo 53  America/Anguilla
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54  America/Antigua 79   America/Guayaquil 104  America/Port_au_Prince

55  America/Asuncion 80   America/Guyana 105  America/PortofSpain

56  America/Adak 81   America/Halifax 106  America/Porto_Acre

57  America/Barbados 82   America/Havana 107  America/Puerto_Rico

58  America/Belize 83   America/Jamaica 108  America/Regina

59  America/Bogota 84   America/Knox_IN 109  America/Santiago

60  America/Buenos_Aires 85   America/La_Paz 110  America/SantoDomingo

61  America/Caracas 86  America/Lima 111  America/Sao_Paulo

62  America/Cayenne 87  America/Los_Angeles 112  America/Scoresbysund

63  America/Cayman 88   America/Managua 113  America/St_Johns

64  America/Chicago 89   America/Manaus 114  America/St_Kitts

65  America/Costa_Rica 90   America/Martinique 115  America/St_Lucia

66  America/Curacao 91   America/Mazatlan 116  America/St_Vincent

67  America/Denver 92   America/Mexico_City 117  America/Tegucigalpa

68  America/Detroit 93   America/Miquelon 118  America/Thule

69  America/Dominica 94   America/Montevideo 119  America/Tijuana

70  America/Edmonton 95   America/Montreal 120  America/Vancouver

71  America/El_Salvador 96   America/Montserrat 121  America/Virgin_Is

72  America/Ensenada 97   America/Nassau 122  America/Whitehorse

73  America/Fort_Wayne 98   America/Navajo 123  America/Winnipeg

74  America/Godthab 99   America/New_York 124  Asia/Aden

75  America/Grand_Turk 100 America/Noronha 125  Asia/Alma_Ata

76  America/Grenada 101  America/Panama 126  Asia/Amman

77  America/Guadeloupe 102  America/Paramaribo 127  Asia/Anadyr

78   America/Guatemala 103  America/Phoenix 128  Asia/Ashkhabad
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129  Asia/Baghdad 154  Asia/Macao 179  Asia/Ulan_Bator

130  Asia/Bahrain 155  Asia/Magadan 180  Asia/Vientiane

131  Asia/Baku 156  Asia/Manila 181  Asia/Vladivostok

132  Asia/Bangkok 157  Asia/Muscat 182  Asia/Yakutsk

133  Asia/Beirut 158  Asia/Nicosia 183  Asia/Yerevan

134  Asia/Brunei 159  Asis/Novosibirsk 184  Atlantic/Azores

135  Asia/Calcutta 160  Asia/Omsk 185  Atlantic/Bermuda

136  Asia/Colombo 161  Asia/Phnom_Penh 186  Atlantic/Canary

137  Asia/Dacca 162  Asia/Pyongyang 187  Atlantic/Cape_Verde

138  Asia/Damascus 163  Asia/Qatar 188  Atlantic/Faeroe

139  Asia/Dubai 164  Asia/Rangoon 189  Atlantic/Madeira

140  Asia/Dushanbe 165  Asia/Riyadh 190  Atlantic/Reykjavik

141  Asia/Bishkek 166  Asia/Saigon 191  Atlantic/South_Georgia

142  Asia/Gaza 167  Asia/Seoul 192  Atlantic/St_Helena

143  Asia/Hong_Kong 168  Asia/Shanghai 193  Atlantic/Stanley

144  Asia/Irkutsk 169  Asia/Singapore 194  Australia/Adelaide

145  Asia/Istanbul 170  Asia/Yekaterinburg 195  Australia/Brisbane

146  Asia/Jakarta 171  Asia/Taipei 196  Australia/Broken_Hill

147  Asia/Jayapura 172  Asia/Tashkent 197  Australia/Darwin

148  Asia/Kabul 173  Asia/Tbilisi 198  Australia/Hobart

149  Asia/Kamchatka 174  Asia/Tehran 199  Australia/Lord_Howe

150  Asia/Karachi 175  Asia/Tel_Aviv 200  Australia/Melbourne

151  Asia/Katmandu 176  Asia/Thimbu 201  Australia/Perth

152  Asia/Kuala_Lumpur 177  Asia/Tokyo 202  Australia/Sydney

153  Asia/Kuwait 178  Asia/Ujung_Pandang 203  Europe/Amsterdam
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204  Europe/Andorra 229  Europe/Oslo 254  GMT+3

205  Europe/Athens 230  Europe/Paris 255  GMT+4

206  Europe/Belfast 231  Europe/Prague 256  GMT+5

207  Europe/Belgrade 232  Europe/Riga 257  GMT+6

208  Europe/Berlin 233  Europe/Rome 258  GMT+7

209  Europe/Bratislava 234  Europe/Sarajevo 259  GMT+8

210  Eruope/Brussels 235  Europe/Skopje 260  GMT+9

211  Europe/Bucharest 236  Europe/Sofia 261  GMT-1

212  Europe/Budapest 237  Europe/Stockholm 262  GMT-10

213  Europe/Chisinau 238  Europe/Tallinn 263  GMT-11

214  Europe/Copenhagen 239  Europe/Tirane 264  GMT-12

215  Europe/Dublin 240  Europe/Vaduz 265  GMT-2

216  Europe/Gibraltar 241  Europe/Vienna 266  GMT-3

217  Europe/Helsinki 242  Europe/Vilnius 267  GMT-4

218  Europe/Istanbul 243  Europe/Warsaw 268  GMT-5

219  Europe/Kiev 244  Europe/Zagreb 269  GMT-6

220  Europe/Lisbon 245  Europe/Zurich 270  GMT-7

221  Europe/Ljubljana 246  GMT 271  GMT-8

222  Europe/London 247  GMT+0 272  GMT-9

223  Europe/Luxembourg 248  GMT+1 273  Indian/Antananarivo

224  Europe/Madrid 249  GMT+10 274  Indian/Christmas

225  Europe/Malta 250  GMT+11 275  Indian/Comoro

226  Europe/Minsk 251  GMT+12 276  Indian/Mahe

227  Europe/Monaco 252  GMT+13 277  Indian/Maldives

228  Europe/Moscow 253  GMT+2 278  Indian/Mauritius

MeetingPlacb
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279  Indian/Mayotte 304  Pacific/Noumea

280  Indian/Reunion 305  Pacific/Pitcairn

281  Pacific/Auckland 306  Pacific/Ponape

282  Pacific/Belau 307  Pacific/Port_Moresby

283  Pacific/Chatham 308  Pacific/Rarotonga

284  Indian/Cocos 309  Pacific/Pago_Pago

285  Pacific/Easter 310  Pacific/Tahiti

286  Pacific/Efate 311  Pacific/Tarawa

287  Pacific/Enderbury 312  Pacific/Tongatapu

288  Pacific/Fakaofo 313  Pacific/Truk

289  Pacific/Fiji 314  Pacific/Wake

290  Pacific/Funafuti 315  Pacific/Wallis

291  Pacific/Galapagos 316  Pacific/Yap

292  Pacific/Gambier 317  Atlantic/Jan_Mayen

293  Pacific/Guadalcanal 318  Indian/Chagos

294  Pacific/Guam

295 Pacific/Honolulu

296  Pacific/Kiritimati

297  Pacific/Kwajalein

298  Pacific/Majuro

299  Pacific/Marquesas

300  Pacific/Midway

301  Pacific/Nauru

302  Pacific/Niue

303  Pacific/Norfolk
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